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1. Introduction
Biomonitoring equivalents (BEs) are defined as the concentration of a chemical (or metabolite) in a biological medium (blood, urine, human milk, etc.) consistent with defined exposure guidance values or toxicity criteria including reference doses and reference concentrations (RfD and RfCs), minimal risk levels (MRLs), or tolerable daily intakes (TDIs).[footnoteRef:2] Physiologically Based Pharmacokinetic (PBPK) models can be parameterized to generate a distribution of biomarker concentrations and then be compared to measured biomonitoring data. In this case study, we will be modeling trichloroethylene (TCE) kinetics using PLETHEM. We are estimating the biomonitoring equivalents for two reference exposures—an IRIS-recommended reference concentration value and an upper 95th percentile exposure estimate from the SEEM3 exposure estimation tool. [2:  Hays, Sean M., et al. Regulatory Toxicology and Pharmacology 47.1 (2007): 96-109.] 

[bookmark: _GoBack]System Requirements:
Windows 10 with: Edge, Firefox, or Chrome
Mac OS 10.14.x or higher, with: Safari, Firefox, or Chrome
Ubuntu with: Firefox
2. What this tutorial covers
Forward dosimetry is the default workflow for PBPK modeling. It allows users to establish internal concentrations from external exposure metrics by accounting for route-of-exposure effects and the distribution, metabolism, and excretion of the chemical in the body. PLETHEM uses a generalized PBPK model description that simulates all major organs in the body and can be used to predict internal dose metrics following external exposure.
In this case study, we go through the steps of parameterizing a model for TCE. We use two sources of exposure information, a reference concentration from the IRIS assessment done by the EPA (Link) and an environmental exposure estimated by EPA’s SEEM3 exposure prediction tool. A database containing SEEM3 estimates for multiple chemicals can be downloaded here. It is also included internally within the rapidPBPK module.
Most workflows in PLETHEM will require users to parameterize a rapidPBPK model through the steps outlined below.
3. Parameterizing the TCE model
Link to rapidPBPK online:
scitovation.com/plethem_live

The rapidPBPK model within PLETHEM is parameterized as a TCE model using chemical-specific values parameters and QSAR models. 
Create an exposure set
Here, we will create three exposure sets, one corresponding to the IRIS Reference Concentration (RfC) and two corresponding to the SEEM3 exposure estimates.
We will use the IRIS continuous chronic RfC value of 0.004 ppm exposed at 24h/day for 7 days a week and save it as an exposure set called “IRIS Inhalation Exposure TCE.” 
1) Navigate to the “Model Setup” tab.
2) Navigate to the “Exposure” tab in the user interface.
3) Select “Inhalation” from the sidebar to show inhalation-exposure inputs.
4) Set the “Inhalation Exposure” to 0.004 ppm, “Duration of Inhalation Exposure” to 24 h/day and ”Exposure days in a week” to 7.
5) Click the “Save As” button to save the set and name it “IRIS Inhalation RfC.” Click “Add” to save the exposure. 
Next, we import SEEM3 estimates into PLETHEM using the Import Data wizard. 
1. [image: ]Click on the “Import Data” button and select the “SEEM Data” tab.
2. If you haven’t already, download the SEEM exposure estimates from this link and save them on your computer
3. Click the “Load SEEM Database” button to load the SEEM database into memory.
4. Select “Workshop Chemicals” from the radio button list under “Select Category” and click the “Get Selected Chemical List” button.
5. Select “Trichloroethylene” from the “Select Chemicals to Import” drop-down menu and click the “Population Upper 95th Percentile” and “Population Median” buttons.
6. Click the “Import Selected Exposures” button. This imports the exposure into the project and creates a new exposure set for it. 
[image: ]The three exposures are now a part of the project in PLETHEM. Please note that the project file at the location saved in Step 3.1 is not changed. The parameter sets created here are saved to the internal project database in PLETHEM.

Create a chemical set
[image: ]PLETHEM uses QSAR models to estimate partition coefficients for distribution of the chemicals. The QSAR models use physical-chemical properties of the substance to estimate these values. We used PubChem and the EPA Comptox dashboard to obtain these values for TCE. 

	[bookmark: _Hlk63243460]PubChem Computed Chemical and Physical Properties from Computed Properties

	Property Name
	Property Value
	Reference

	Molecular Weight
	131.38 g/mol
	Computed by PubChem 2.1 (PubChem release 2019.06.18)

	XLogP3
	2.6
	Computed by XLogP3 3.0 (PubChem release 2019.06.18)

	Hydrogen Bond Donor Count
	0
	Computed by Cactvs 3.4.6.11 (PubChem release 2019.06.18)

	Hydrogen Bond Acceptor Count
	0
	Computed by Cactvs 3.4.6.11 (PubChem release 2019.06.18)

	Rotatable Bond Count
	0
	Computed by Cactvs 3.4.6.11 (PubChem release 2019.06.18)

	Exact Mass
	129.914383 g/mol
	Computed by PubChem 2.1 (PubChem release 2019.06.18)

	Monoisotopic Mass
	129.914383 g/mol
	Computed by PubChem 2.1 (PubChem release 2019.06.18)

	Topological Polar Surface Area
	0
	Computed by Cactvs 3.4.6.11 (PubChem release 2019.06.18)

	Heavy Atom Count
	5
	Computed by PubChem

	Formal Charge
	0
	Computed by PubChem

	Complexity
	42.9
	Computed by Cactvs 3.4.6.11 (PubChem release 2019.06.18)

	Isotope Atom Count
	0
	Computed by PubChem



The values from these data sources are then used to populate the user interface. 
1) Navigate to the “Chemical” tab in the user interface.
2) [image: ]Enter the appropriate input values as shown in the figure below except the “Fraction Dissolved in Liquid Phase of Plasma” value, which will be populated in the next step.

	[bookmark: _Hlk63243417]Chemical Parameters

	Density
	1 g/L

	Molecular Weight
	131.4 g/mol

	Vapor Pressure at 25°C
	9199 Pa

	Log Ko/w in Skin at pH5.5
	1

	Log Ko/w (Octanol:Water Coefficient)
	2.61

	Water Solubility
	1280 mg/L

	Fraction Reabsorbed in Kidney
	0

	Fraction Unbound in Plasma
	0.065



3) Click on the “Estimate Fraction Dissolved” button to estimate fraction of the chemical dissolved in the liquid phase of plasma. The “Fraction Dissolved in Liquid Phase of Plasma” box value should match the figure above.
4) Click “Save As” to save the parameter set as “TCE Chemical Parameters.” Click “Add” to save chemical parameters. 
Create a physiological set 
We simulate an adult human male in this case study. To create a standard adult human male physiology description:
1. Navigate to the “Physiological” tab in the user interface.
2. Select “Human” and “Male” under the “Organism” and “Gender” drop-downs menus, respectively. Set “Age” to “25.”
3. Click the “Calculate Physiological Parameters” button to parameterize the model using life-course equations in PLETHEM. The values should match the figure below. 
4. [image: ]Click the “Save As” button to save the parameter set. Name the set “Adult Human Male.” Click “Add” to save the physiological parameters.

Create an ADME set
In PLETHEM, the ADME set is used to specify parameters related to absorption, distribution, metabolism, and excretion. They need to be defined for a specific combination of chemical, metabolite, exposure, and physiology. In this case study, we are not tracking the metabolite of TCE in the model. Hence, the metabolite selection is set to “No Metabolite.”
The “Absorption” and “Excretion” parameters in this case study are left to their default values. The tissue partitioning is calculated at the partition tab by taking the following steps: 
1. Navigate to the “ADME” tab in the user interface.
2. Select the “Distribution” tab.
3. Select “QSAR Model One” to be used for estimating partitioning. The “QSAR Model One” refers to the default QSAR model in PLETHEM, which is adapted from the algorithm published by DeJongh et al. 1997.[footnoteRef:3] [3:  DeJongh, J., H.J. Verhaar, and J.L. Hermens, A quantitative property-property relationship (QPPR) approach to estimate in vitro tissue-blood partition coefficients of organic chemicals in rats and humans. Arch Toxicol, 1997. 72(1): p. 17-25.] 

4. [image: ]Click the “Calculate Partition” button to estimate partition coefficients for all tissues that are part of the model. The values should match the figure below.

[image: ]TCE metabolism is defined under the “Metabolism” tab in the ADME user interface. We use the IVIVE algorithm within PLETHEM to scale the intrinsic clearance predicted by the OPERA models (1.50366e-6 L/h/106 Hepatocytes) to intrinsic clearance in vivo.
1. Select the “Metabolism” tab to display metabolism-related inputs.
2. Click the “Perform IVIVE” button to open the IVIVE interface. 
3. Under the “Hepatocyte Clearance,” enter the value of 1.50366e-6 and choose the appropriate units from the “Units” drop-down menu (L/h/10^6 Hepatocytes). 
4. Select “Metabolism Type” to be linear.
5. Click the “Perform IVIVE” button to extrapolate intrinsic clearance in vitro to intrinsic clearance in vivo.



The entire ADME set is then saved along with the chemicals, physiology, and exposure set it represents. This will be used later to filter the appropriate ADME set for selection when creating a simulation from these building blocks. Because we have two exposure scenarios, we need to create two ADME sets—one for each exposure scenario to account for any differences.
1. For the first ADME set, we will use the IRIS Inhalation exposure, which can be selected from the drop-down menus located in the “ADME” user interface. See the figure below.
[image: ]
2. Click “Save As” to save the exposure scenario. Name the scenario “ADME Set for IRIS Inhalation Exposure.” Click “Add” to save the exposure.
3. [bookmark: _Hlk44173773]For the second ADME set, we select the “Trichloroethylene Population Upper 95th Percentile.” See the figure below. [image: ]
4. Click the “Save As” button to save the exposure scenario. Name the scenario “Trichloroethylene Population Upper 95th Percentile.” Click “Add” to save the exposure.
[image: ]You should now be able to see both exposures in the drop-down menu.
In this case, the ADME sets have different absorption-related parameters because they have distinct routes of exposure. While modeling with PLETHEM, the user may choose to create multiple ADME sets for the same chemical, exposure, and physiology to investigate the differences in ADME processes.
Define variability
For this model, we account for differences in body weight, cardiac output, tissue volume, blood flow, and respiratory rate between individuals. Variability is defined in PLETHEM as an uncertainty and variability set for parameters in each of the four previously defined sets. This set is saved as a physiological variability set. 
1) Navigate to the “Uncertainty and Variability” tab in the user interface.
2) Select “Physiological” from the sidebar.
3) Click on the “New” button to open the variability interface. Name this set “Physiological Variability.”
4) Select “Body Weight,” “Cardiac Output” and “Respiration Rate” from the drop-down menu located under the “Select Parameters to Assign Variability” and click the “Update List” button. This will also lead to different tissue volumes and blood flows to be scaled appropriately.
5) Assign “Coefficient of Variation” and “Type of Distribution” to the parameters as shown in the figure below. 
Click “Done” to save the variability set. [image: ][image: ] At this point it is a good idea to save the entire project by clicking the “Save” button in the “File” menu. The program will jump to the home screen but no data will be erased in the web version. Click the “Model Setup” button to continue.
	[bookmark: _Hlk63243169]Import Data, SEEM Data Selections

	Body Weight
	0.3 Log-normal

	Cardiac Output
	0.3 Log-normal

	Respiration Rate
	0.3 Log-normal



Create a simulation
All the sets are put together to create a simulation. We will create two simulations, one with inhalation exposure and one with SEEM exposure estimate.
1) Navigate to the “Simulations” tab in the user interface.
2) Click “New” to launch the “Simulation” dialog.
3) Name the simulation “TCE Simulation for Inhalation RfC” and add a description. The description field is used by PLETHEM when generating a report of the simulation but is not required.
4) Select “Forward Dosimetry with Monte Carlo” as the “Simulation Type.”
5) Under the “Parameters” tab, make sure the appropriate “Exposure,” “Parent Chemical,” “Physiology,” and “ADME” tabs are selected. For the first simulation, we will select “IRIS Inhalation RfC” as the “Exposure.” 
6) Under the “Variability” tab, make sure “Physiological Variability” is selected under the “Physiology” menu. Remember we are only varying the physiology in this simulation.
7) Under the “Simulation” tab, set the “Simulation Start Time” to 0, “Simulation Duration” to 1, and “Duration Units” to Days. Effectively, we will be running a 24h simulation starting at 0. The default number of Monte Carlo runs is set to 1000.
8) Click the “Create Simulation” button to save the simulation.
9) Create another Monte Carlo simulation following the same steps with the SEEM exposure instead and name it “TCE Simulation for 95th Percentile SEEM Exposure.”
[image: ]We can now choose one of the simulations and select the “Run” button to conduct a Monte Carlo simulation and generate a concentration distribution.
Running the simulation 
1. Select the simulation you wish to run from the drop-down menu.
2. Click the “Run” button. Because the selected simulation here is a Monte Carlo simulation, a progress bar will appear above the “Run Simulation” as the simulation proceeds in the bottom right corner.
3. After the simulation is complete, PLETHEM will switch over to the “Model Outputs” tab.
Viewing and exporting simulation results
The “Model Output” tab allows users to view and export simulation results such as tissue concentrations and amounts. It also contains interfaces for importing datasets to plot against simulation results for viewing the results from Non-compartmental Analysis. For this case study, we look at the arterial concentration of TCE and several tissues following the exposure we selected. 
1. Select the “Plots” tab on the “Model Outputs” page.
2. Select the “Concentration” panel and select “Arterial Plasma,” “Liver Tissue,” “Rapidly Perfused Total,” and “Slowly Perfused Total” from the multiple selection menu on the left.
3. [image: ]This creates a box plot for the arterial plasma concentration and liver, rapidly and slowly perfused tissue concentrations in the plot window on the right. You should see the figure below.

4. [image: ]Selecting the “Table” tab on the concentration panel brings up the actual Cmax values behind the box plot. These Cmax values can be exported by clicking on the “Get Data” button below the table. 

Save the project and quit the user interface 
To save the project, navigate to the location first selected when creating the project and click the “Save” button from the file menu. To quit the app, click the “Quit” button on the file menu.
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